
 

 

 

 

 

 

 

 

User’s Manual 
Version 2.0 

 

 

 

 

 

© Copyright 2008, 3230 Systems, LLC 

 

 



Contents 

Installation .................................................................................................................................................... 4 

Initial Installation ...................................................................................................................................... 4 

Windows Vista ...................................................................................................................................... 4 

Installation Procedure for Additional Machines ....................................................................................... 4 

Add-in for Microsoft Outlook ................................................................................................................ 4 

Running CollabTask for the First Time ...................................................................................................... 4 

Local Data Storage ................................................................................................................................ 4 

Storing Your Data on a Database Server ............................................................................................... 4 

Changing Database Configuration ............................................................................................................ 5 

CollabTask Administration ............................................................................................................................ 5 

User Maintenance ..................................................................................................................................... 5 

Team Users............................................................................................................................................ 5 

Applying a License Key .............................................................................................................................. 6 

Basic Task Management ............................................................................................................................... 6 

Orientation ................................................................................................................................................ 6 

Adding a Task ............................................................................................................................................ 6 

Modifying a Task ....................................................................................................................................... 7 

History Comments .................................................................................................................................... 7 

Deleting a Task .......................................................................................................................................... 7 

Task Details ............................................................................................................................................... 7 

Projects ......................................................................................................................................................... 8 

The Project Scratchpad ............................................................................................................................. 9 

Predecessors in the Project Scratchpad ................................................................................................ 9 

Selecting, Sorting and Viewing Tasks .......................................................................................................... 10 

To-Do View vs. Project View ................................................................................................................... 10 

To-Do View .......................................................................................................................................... 10 

Project View ........................................................................................................................................ 11 

Selecting Which Tasks to View ................................................................................................................ 11 

Project Selection Box .......................................................................................................................... 11 

User Selection Box .............................................................................................................................. 11 



Status Selection Box ............................................................................................................................ 11 

Sorting Tasks ........................................................................................................................................... 12 

Changing Columns .................................................................................................................................. 12 

Resizing Columns ................................................................................................................................ 12 

Moving Columns ................................................................................................................................. 12 

Saving Views............................................................................................................................................ 12 

Predecessors & Successors ......................................................................................................................... 12 

Creating and Removing Predecessors/Successors.................................................................................. 12 

The Task Status Icon................................................................................................................................ 12 

The History Panel ........................................................................................................................................ 13 

Printing & Exporting .................................................................................................................................... 13 

Printing .................................................................................................................................................... 13 

Exporting ................................................................................................................................................. 13 

 

  



Installation 

Generally speaking, CollabTask only needs to be installed once in an organization.  Everything the 

program needs will be stored in the directory chosen during installation.  For this reason, multiuser 

installations should be stored on a network or shared location that all users have access to. 

Initial Installation 
The initial installation of CollabTask is accomplished by following the download link at 

http://www.collabtask.com.  For a multiuser installation, override the default program location.  Note: If 

you’ve already installed the program to a local directory, you can simply copy or move the program 

folder to the correct location. 

Windows Vista 

If you are running Windows Vista you may need to be logged in as an administrator to complete the 

installation. 

Installation Procedure for Additional Machines  
As mentioned above, no per-machine installation in necessary.  Users simply need to run CollabTask.exe 

from the program folder.  You may create a desktop shortcut, or add an entry to the startup folder to 

automatically launch CollabTask. 

Add-in for Microsoft Outlook 

If you have not run the installation program on your computer, and use Microsoft Outlook, and would 

like to be able to easily add e-mail messages and tasks to CollabTask, you will also need to register the 

CollabTask Add-in.  To do this, choose Command Prompt from the Windows Start menu (usually in the 

Accessories folder).  Vista users should right-click the Command Prompt option and choose Run As 

Administrator).  Change the current directory to the CollabTask program directory and type… 

  regsvr32 ctoutl.dll 

CollabTask will appear in the Outlook toolbar the next time Outlook is started. 

Running CollabTask for the First Time 
The first time CollabTask is run, it will ask how you would like your data stored.  You have three options: 

 Local Data Storage 

This option is recommended when a database server is not readily available for 

installations of up to 5 users and for evaluation purposes.  It is the easiest to configure as 

everything is automatic.  The data will be stored in a Data subdirectory under the program 

directory. 

 Storing Your Data on a Database Server 

A database server is recommended for larger installations.  CollabTask supports 

Microsoft’s SQL Server and MySQL from Sun Microsystems.  If you wish to use a database 

server you will need to use your server’s administration tool to create a database for 

http://www.collabtask.com/


CollabTask and a user account for CollabTask to use.  This account will need full access to 

the database.  The account will also need a password.  CollabTask does not support SQL 

Server’s Integrated Security feature. 

Once you have selected which database server to use, you must then specify the Server 

Name (or Address), the Username and Password (this will be stored in the configuration in 

an encrypted format), and the Database name.  CollabTask will then create the database 

tables it needs. 

Changing Database Configuration 
If you find that you would like to change the database configuration, you can delete the CollabTask.ini 

found in the program directory.  Starting CollabTask again will bring up the database configuration 

dialogs again.  However, the only way to retain your current data is to select the same server and 

database (or a copy if one has been made). 

CollabTask Administration 

 

User Maintenance 
Use the Users menu option under Administration to manage CollabTask Users.  Five pieces of 

information are associated with each user: 

 Username – This is the Windows username and is checked against the current user when 

CollabTask starts.  If the username is not in the CollabTask database execution is prevented. 

 Display Name – The name displayed for the user within CollabTask.  By default it is set to the 

Username but may be set to a friendlier name. 

 Enabled – Indicates whether the user may run CollabTask.  Only enabled users count against the 

licensed user count. Tasks may be assigned to users that are not enabled (see Team Users). 

 Administrator – Administrators have the Administration menu available to them and can 

maintain the user list, delete old tasks and apply license keys. 

 Project Maintenance – Indicates whether the user can add and modify projects.  Administrators 

can always maintain projects. 

Team Users 

A dummy user may be set up to represent a team.  These users should not be enabled so that they do 

not count against the licensed user count.  Other users may may opt into the team by adding the team 

user to their normal task selection criteria.  As a result, tasks assigned to a team user will appear for all 

members of the team.  It is recommended that the user who begins the task reassign it to his/her own 

username so that no one else will begin the task. 



Applying a License Key 
CollabTask ships with a limit of two enabled users.  Purchase additional user packs to add to this 

number.  You will receive a license key file which contains your total number of licensed users.  Typically 

you will receive this as an attachment to an e-mail.  Save the attachment a store a copy among your 

backups.  To apply the new limit, choose Apply License Key from the Administration menu and select the 

license key file.  Restart CollabTask. 

Basic Task Management 

Orientation 
Throughout this document we will to various areas of the main CollabTask window:  To-Do View, Project 

View, Task Info Pane, Predecessors/Successors Pane, History Pane and the Task Selection bar. 

 

 

Adding a Task 
You can add a task in one of three ways: 

 Select Insert Task from the Edit menu 

 Right-Click in the To-Do or Project View and choose Add Task 

 Press the <Ins> key 

After adding a task, enter a title for the task and optionally enter/change data on the Task Info panel. 

When your changes are complete, save them by pressing <Enter> or clicking the checkmark button at 

the bottom of the Task Info panel. 

Panels: 

Task Info 

Predecessors 

/Successors 

Task History 

Task 

Selection Bar 

Views: 

 To-Do/ 

Project 

History Comment 

Task Info 

Predecessors /Successors 

Task History 



To cancel your insertion, press <Esc> or click on the X button at the bottom of the Task Info panel. 

If you move to another task after adding or editing a task your changes will be saved.  However, it is 

safer to explicitly commit your changes by pressing the Save Changes button or pressing <Enter>. 

Modifying a Task 
To modify an existing task, simply modify the values in the task info pane or in the grid on the To-Do or 

Project Views.  Save or cancel your changes 

History Comments 
 The edit box to the right of Save/Cancel  Changes buttons is the History Comment.  You may enter a  

comment to be shown on the Task History Panel for this change.  Use this to communicate the reason 

for certain changes.  For instance, if you are correcting a priority based on your internal policies, you 

may enter a comment such as “Please use priority 1 only for client service issues.” 

Deleting a Task 
To delete a task, select a task in the To-Do/Project View and do one of the following: 

 Select Delete Task from the Edit Menu, or 

 Right-click on the To-Do or Project View and select Delete Task, or 

 Press <Ctrl><Del>, or 

 Change the task status to Deleted. 

When you delete a task you are really only setting the status to Deleted.  This allows you to later 

determine if a missing task was deleted, and by whom.  To permanently delete tasks, use the Delete Old 

Tasks option on the Administration Menu. 

Task Details 
The following details are available for each task…. 

 Task Title – A short title for the task. 

 Assigned To – The user (or group) assigned to the task. 

 Status – Deleted, Incomplete, Complete or On Hold. 

 Due Date – Date that the task is dues to be completed. 

 Priority – A value from 1 (highest) to 10 (lowest). 

  Estimated Completion Date – Date that the task is expected to be complete. 

 Working – A check box indicating that work is current progressing on the task. 

 Project – The project that the task belongs to. (Note: On the drop-down project tree, a single-

click is used to navigate the tree.  You must double-click a project to select it) 

 Description – A free-form text field to specify additional details or instructions. 



Projects 

CollabTask allows you to organize your tasks into projects.  Projects may contain tasks and other 

projects, but tasks cannot contain projects.  Your user account must be enabled for project maintenance 

in order to add or change projects.  There are three ways to create a project: 

 On the Projects window, available from the Projects option of Projects menu. 

 In the Project View. 

 In the Project Scratchpad. 

The Projects window is the preferred location to perform general project maintenance.  Here, you may 

choose which projects are displayed by selecting a combination of project statuses. 

 

Each Project has the following data fields: 

 Title – The name of the project. 

 Status – Incomplete, Complete or On Hold. 

 Owner – User responsible for the project (optional). 

 Start Date – The start date of the project (optional). 

 Due Date – The date that the project is due to be complete (optional). 

 Date Complete – The date the project was completed (optional). 

Except for the status, these fields are informational only.  The status is only used to indicate whether the 

project is listed in the drop-down project selection boxes.  The completion of all of the tasks under a 



project does not automatically set the project to a completed status.  This allows for open-ended 

projects. 

Projects may be dragged into other projects on the project tree.  All child projects and tasks will follow 

them into the selected location. 

The Project Scratchpad 
The Project Scratchpad is a powerful feature that can help you to easily design and replicate projects.  

You can start from scratch or copy an existing project by right-clicking on a project in the Project View 

and selecting Copy to Project Scratchpad.  In addition, you can save projects in the project scratchpad to 

reusable templates for future use. 

 

You may right-click anywhere in the project tree to add or delete tasks.  Tasks and projects may be 

dragged into their proper positions in the tree.  No changes are made to the CollabTask data until you 

press the Create New Project button.  At that point, the entire project tree will be added to CollabTask.  

Alternatively (or, in addition) you can save the project as a template.  To load the template at  a later 

date, click on the Templates tab, select a template and press the Load Template button. 

Predecessors in the Project Scratchpad 

You can quickly view and assign predecessors of a task by using the predecessor pane to the left of the 

project tree.  When a task is selected, its predecessors are indicated by blue lines in the predecessor 

pane. 



 

To create predecessors, move your mouse cursor into the predecessor pane.  As you move the cursor up 

and down to the left of tasks, they will be highlighted in a blue or yellow color. 

  

 
 Ok to set as predecessor 

 
 Not a valid predecessor 

With a task highlighted in blue, click to add it as a predecessor.  Click again to remove the predecessor 

status. 

Selecting, Sorting and Viewing Tasks 

 

To-Do View vs. Project View 
There are two main views available in CollabTask; To-Do View and Project View.   

To-Do View 

On the To-Do View, tasks are displayed in a single to-do list format, typically ordered by priority.  You 

may be a part of several projects, but can only work on so many tasks at once.  The To-Do View allows 



you and others view all of your tasks together and can help identify conflicts between projects and allow 

management to reconcile your priorities so that everyone is comfortable with the order in which tasks 

are being addressed. 

Project View 

The Project View arranges your tasks by projects.  Projects may contain several levels of sub-projects 

and these are arranged in an expandable tree format.  There may be many projects in an organization 

but only a few for which you have responsibilities.  As such, only those projects that include selected 

tasks are displayed. 

If you have been authorized to modify projects, you may also edit and add projects in the Project View 

(see: Projects). 

Selecting Which Tasks to View 
The Task Selection Bar has three selection controls that allow you to choose which tasks to display.  

These selections apply to both the To-Do View and the Project View.  In each box, un-checking all the 

boxes is the same as checking them all. 

Project Selection Box 

Use the Project Selection Box to select which projects to view.  Selecting a parent project automatically 

selects all of its children.   

Caution: To be sure you are viewing all of your open tasks; it is highly recommended that you clear the 

project selections.  Someone may add a task for you under a project you didn’t expect, or a newly 

created project you are unaware of. 

User Selection Box 

Use the user selection box to view tasks for specific users.  Often, you will want to view tasks only for 

yourself.  However, you can also view tasks for your team or anyone else.  CollabTask encourages this.  

Do not enter tasks into CollabTask that you wouldn’t want any other CollabTask user in your 

organization to see. 

Team users can be created by creating a dummy, disabled user (i.e. a user that cannot log into 

CollabTask, but may be assigned tasks).  You may opt into a team by including its tasks in the user 

selection of your normal selection settings.  As an example, Bob and Sally may both be Human Resource 

Analysts and either can complete many HR tasks.  An ‘HR Analyst’ user can be created and Bob and Sally 

can be instructed to include this user with their task selections.  Tasks can be assigned to the ‘HR 

Analyst’ user and they will appear on both Bob and Sally’s to-do lists.  It is recommended that if either 

begin to work on the task, that they reassign it to their self.  That will lessen the possibility that both will 

work on the same task.  Of course, an HR manager may also review Bob and Sally’s tasks and reassign 

the task to the most available person. 

Status Selection Box 

Use this box to select tasks by status. 



Sorting Tasks 
You may change the sort order of the task displays by selecting the Sort option on the View menu.  

Select your sort fields from the list on the left.  Use the Up and Down buttons to rearrange the order of 

the sort fields. 

Changing Columns 

Resizing Columns 

You can resize columns on the task grid by positioning the mouse cursor between two column headings 

and clicking dragging to set the desired column width. 

Moving Columns 

Columns may be moved by clicking and dragging a column title to another position in the grid. 

Saving Views 
You may save your current view settings so that you can quickly reestablish them in the future.  Select 

your desired settings and choose Save Current View as… from the View menu.  Enter a name and press 

okay.  The view should now be available under the Saved Views menu option. 

Predecessors & Successors 

Some tasks cannot be completed until other tasks are complete.  The tasks which must be completed 

are termed predecessors.  Projects may not be predecessors.  Creating a predecessor task automatically 

creates a successor task and vice versa.  The predecessors and successors of a task may be views on the 

Predecessors/Successors Panel.  On this panel you may also create, assign or remove predecessors and 

successors. 

Creating and Removing Predecessors/Successors  
Press the Assign… button to assign an existing task as a predecessor or successor to the current task.  

Press Create New to create a new task which will be a predecessor or successor of the current task.  

Press Remove to remove the currently selected predecessor/successor relationship. 

The Task Status Icon 
The square icon to the left of the task title identifies the status of the current task as well as its 

predecessors and successors. 



 

Note: CollabTask does not prevent the completion of a successor task if its predecessors are not 

complete.  In some cases you may have all the information necessary to complete a task even though its 

predecessors are not technically complete.  CollabTask is not intended to prevent the completion of 

your tasks. 

The History Panel 

The history panel allows you to view the history of a task.  Each change is listed in the history grid and 

the details of the change are listed below.  This panel is read-only. 

Printing & Exporting 

You may print or export the tasks currently displayed by selecting Print or Export from the File menu.   

Printing 
When printing, you have additional options so you can print only the currently selected project, the 

projects whose trees you have expanded you the entire view.  You may also select how much data you 

would like to include by specifying whether to print the Description, predecessors and successors and 

the task history. The columns are arranged in the same order as your view and the output will reflect 

your currently select view (To-Do or Project). 

If you save your view, the printing options will also be saved.   You can save views specifically for 

printing. 

Exporting 
You can export your task data by exporting the data to a tab-delimited data format suitable for 

importing into other applications such as Microsoft Excel.  Simply specify a data file name.  All tasks in 

the current view will be exported. 

 


